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Introduction a Arduino

1. Les outils et leurs
utilisations

Avant de commencer a programmer et a monter des circuits avec Arduino, il est essentiel de
comprendre les composants de base et leur role :

LED (Diode électroluminescente) :

o Permet le passage du courant dans un seul sens.

o Possede une patte plus courte correspondant a la borne négative (cathode).
o A une tres faible résistance.

Résistance :

o Permet de limiter le courant circulant dans un circuit.

o Utilise la loi d’'Ohm : U = R x I (U : tension, R : résistance, | : courant).

o La pile peut compenser les variations de courant.

Condensateur :

o Stocke et libere I'énergie électrique selon les besoins du circuit.
Potentiometre :

o Permet de faire varier la tension.

o Utilisé pour permettre a I’Arduino d’interagir avec I'utilisateur.
Transistor :



o Permet de contréler des tensions plus élevées avec Arduino.
o Par exemple, un moteur fonctionnant en 12V (trop élevé pour I’Arduino) peut étre
piloté a I'aide d'un transistor.
o Régulateur de tension:
o Permet de convertir une tension de 12V en 5V pour adapter I'alimentation des
composants.

2. Premiers pas avec Arduino
IDE

Pour programmer notre Arduino, nous avons ouvert Arduino IDE et accédé a un exemple de code
en suivant ces étapes :

1. Ouverture d’un exemple de code Blink :
e Aller dans File > Examples > Basics > Blink.
o Vérifier que la carte Arduino est bien sélectionnée :
o Tools > Board > Arduino AVR > Arduino Uno.
o Tools > Port > Dev CU (sélectionner le premier port détecté).
2. Test de la carte Arduino :
e Nous avons d’'abord vérifié que I’Arduino fonctionnait correctement en chargeant le
programme Blink, qui fait clignoter une LED embarquée.
e Ensuite, nous avons modifié la durée du clignotement en changeant la valeur des
délais (de 1000ms a 5000ms).

3. Réalisation des premiers
montages

Premier montage : LED clighotante

Nous avons réalisé notre premier circuit en utilisant :

e Une LED.
e Une résistance pour limiter le courant.



Ensuite, nous avons écrit un programme permettant de faire clignoter la LED.

Il faut mantenant faire le code pour faire glignonté la LED :

Blink.ino

1 #define LED 3

3 // the setup function runs once when you press reset or power the board
4 void setup() {

5 // initialize digital pin LED_BUILTIN as an output.

6 pinMode(LED, OUTPUT);

7 ¥

8

9 // the loop function runs over and over again forever
10 void loop() {

1% digitalWrite(LED, HIGH); // turn the LED on (HIGH is the voltage level)
12 delay(5000); // wait for a second

13 digitalWrite(LED, LOW); // turn the LED off by making the voltage LOW
14 delay(1000); // wait for a second

15 H

16

Deuxi@éme montage : Bouton-poussoir

Apres avoir appris a faire clignoter une LED, nous avons ajouté un bouton-poussoir alimenté en
5V.
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1. Nous avons téléversé un programme permettant de détecter I'appui sur le bouton.
/ ‘ -
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2. Apres l'upload du code, nous avons ouvert le moniteur série :

e Aller dans Tools > Serial Monitor.

e Une fenétre s’affiche indiquant lorsque le bouton est pressé.
sketch_feb7b.ino

h #define BOUTON 2

£

3 void setup() {

4 pinMode (BOUTON, INPUT);

5 Serial.begin(9600);

6 }

7

8  void loop() {

9 int etat_bouton = digitalRead{BOUTON);

10

11 if(etat_bouton == 1){

12 Serial.println("Bouton pressé");

13 H

14

15 delay(100);

16 }

17

18 |

19
Output  Serial Monitor X ¥
Message (Enter to send message to 'Arduino Uno' on ‘/dev/cu.usbmodem14301’) New Line ¥ 9600 bau

Bouton pressé
Bouton pressé
Bouton pressé
Bouton pressé
Bouton pressé

Troisieme montage : Potentiometre

Nous avons ajouté un potentiometre au circuit.
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e En tournant le potentiomeétre, la tension de sortie varie.
e Cette variation est détectée par I’Arduino et affichée sur le moniteur série.

sketch_feb7c.ino

1 #define POT A0

2
3 void setup() {
4 pinMode(POT, INPUT);
5 Serial.begin(9600);
6
7 ¥
8
9  void loop() {
10 int valeur = analogRead(POT);
b i
12 Serial.print("Valeur du potentiomeétre : ");
13 Serial.println(valeur);
14
15 delay(200);
16 }
17
Output  Serial Monitor X Yy O =

Message (Enter to send message to 'Arduino Uno' on ‘/dev/cu.usbmode New Line ¥ 9600 baud hd

Valeur du potentiométre : 281
Valeur du potentiometre : 281
Valeur du potentiométre : 281
Valeur du potentiométre : 281
Valeur du potentiométre : 281
Valeur du potentiométre : 281

Ln 1, Col 15 Arduino Uno on /dev/cu.usbmodem14301 (22 B

Quatrieme montage : Capteur 12C

Nous avons expérimenté |'utilisation d'un capteur communicant en 12C, tel que :

e Un capteur de luminosité.
e Un capteur de température.
e Un capteur d’humidité.

Le branchement des capteurs 12C se fait sur les broches SDA et SCL. Pour connecter ces capteurs,
nous avons utilisé un shield qui se place par-dessus la carte Arduino.
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Blink.ino

1N #define LED 3

void setup() {

pinMode(LED, OUTPUT);
}

0N U A WN

©

10 void loop() {

11 digitalWrite(LED, HIGH);
12 delay(5000) ;

13 digitalWrite(LED, LOW);
14 delay(1000);

15 b

16

Il faut maintenant chercher le code correspondant a notre capteur dans la librairie de I'application
Arduino IDE. Dans notre cas, il s’agit du capteur SHT35.

Ci-dessous, le montage du capteur :

Code correspondant au capteur SHT35:


https://wiki.fablab.sorbonne-universite.fr/BookStack/uploads/images/gallery/2025-02/whatsapp-image-2025-02-07-at-11-08-40.jpeg
https://wiki.fablab.sorbonne-universite.fr/BookStack/uploads/images/gallery/2025-02/img-9430.jpeg

basic_demo.ino

1k #include "Seeed_SHT35.h"
2
3
4 /*SAMD corex/
5 #ifdef ARDUINO_SAMD_VARIANT_COMPLIANCE B
6 #define SDAPIN 20
7 #define SCLPIN 21
8 #define RSTPIN 7
9 #define SERIAL SerialUSB
10 #else
11 #define SDAPIN A4
12 #define SCLPIN A5
13 #define RSTPIN 2
14 #define SERIAL Serial|
15 #endif
16
17 SHT35 sensor(SCLPIN);
18
19
20 void setup() {
21 SERIAL.begin(115200);
22 delay(10);
Output  Serial Monitor X ¥y @ =

New Line ¥ 115200 baud =

read data :
temperature = 21.14 °C
humidity = 36.12 %

basic_demo.ino

20 void setup() {

21 SERIAL.begin(115200);

22 delay(10);

23 SERIAL.println("serial start!!");

24 if (sensor.init()) { .

25 SERIAL.println("sensor init failed!!");

26 }

27 delay(1000);

28 }

29

30

31 void loop() {

32 ul6 value = 0;

33 u8 datal6] = {0};

34 float temp, hum;

35 if (NO_ERROR != sensor.read_meas_data_single_shot(HIGH_REP_WITH_STRCH, &temp, &hum)) {

36 SERIAL.println("read temp failed!!");

37 SERIAL.println(" ");

38 SERIAL.println(" ")

39 SERIAL.println(" )

40 } else {

41 SERIAL.println("read data :"):
Output  Serial Monitor X ¥y O =
Message (Enter to send message to 'Arduino Uno' on '/dev/cu.usbmodem14501') New Line ¥ 115200 baud v

read data :
temperature = 21.14 °C
humidity = 36.12 %
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basic_demo.ino

39 SERIAL.printin(" )5
40 } else {
41 SERIAL.println("read data :");
42 SERIAL.print("temperature = ");
43 SERIAL.print(temp); L
44 SERIAL.println(" 'C ");
45
46 SERIAL.print("humidity = ");
47 SERIAL.print(hum);
48 SERIAL.println(" % ");
49
50 SERIAL.println(" =
51 SERIAL.println(" )
52 SERIAL.println(" LA
53 }
54 delay(1000) ;
1] }
56
57
58
59
60
Output  Serial Monitor X ¥y 0O =
New Line ¥ 115200 baud o
read data :

temperature = 21.14 °C
humidity = 36.12 %

Cinquieme montage:

On branche une led ainsi qu’une résistance sur notre montage Arduino, shield et capteur
thermique et d’humidité.
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En réchauffant le capteur avec nos mains, on peut faire augmenter la température autour du
capteur et ainsi allumer la led (a partir de 23°C). On observe qu’en retirant nos mains, la led
s'éteint lorsqu’elle passe en dessous du seuil des 23°C.
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Sixieme montage:

Branchement du cerveau moteur:
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Code servant a faire bouger le servo moteur grace au potentiometre:
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Knob.ino readme.md

1 /%

2 Controlling a servo position using a potentiometer (variable resistor)

3 by Michal Rinott <http://people.interaction-ivrea.it/m.rinott>

4

5 modified on 8 Nov 2013

6 by Scott Fitzgerald

7 http://www.arduino.cc/en/Tutorial/Knob

8 */

9

10 #include <Servo.h>

14

12 Servo myservo; // create Servo object to control a servo

13

14 int potpin = A@; // analog pin used to connect the potentiometer

15 int val; // variable to read the value from the analog pin

16

17 void setup() {

18 myservo.attach(9); // attaches the servo on pin 9 to the Servo object

19 }

20

21 void loop() {

22 val = analogRead(potpin); // reads the value of the potentiometer (value between @ and 1023)
23 val = map(val, @0, 1023, @, 180); // scale it for use with the servo (value between @ and 180)
24 myservo.write(val); // sets the servo position according to the scaled value
25 delay(15); // waits for the servo to get there

26}

27|

Code servant a faire bouger le servo moteur seul:
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Sweep.ino  readme.md
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P* Sweep
by BARRAGAN <http://barraganstudio.com>
This example code is in the public domain.

modified 8 Nov 2013

by Scott Fitzgerald

https://www.arduino.cc/en/Tutorial/LibraryExamples/Sweep
*/

#include <Servo.h>

Servo myservo; // create Servo object to control a servo
// twelve Servo objects can be created on most boards

int pos = @; // variable to store the servo position

void setup() {
myservo.attach(9); // attaches the servo on pin 9 to the Servo object

}

void loop() {
for (pos = @; pos <= 180; pos += 1) { // goes from @ degrees to 180 degrees
// in steps of 1 degree

myservo.write(pos); // tell servo to go to position in variable 'pos'
delay(15); // waits 15 ms for the servo to reach the position
}
for (pos = 180; pos >= @; pos —= 1) { // goes from 180 degrees to @ degrees
myservo.write(pos); // tell servo to go to position in variable 'pos'
delay(15); // waits 15 ms for the servo to reach the position
H

}

OBJECTIF POUR LA PROCHAINE FOIS :

=> Créer un code qui combine ce qu’on a vu aujourd’hui.

Ce qu’on veut faire: utiliser le capteur pour pouvoir faire monter la température et donc faire
bouger le servo moteur a partir de 23°C.

IDEE DE PROJET FINAL :

Une version simplifiée du projet de la **mini serre automatisée** pourrait étre de créer un
**systeme d’irrigation automatique a base de capteur d'humidité**, sans intégrer d'écran LCD ni
autres éléments complexes.

Voici une version plus simple :

### **Projet : Systeme d'irrigation automatique simplifié**

- *kDéfinition du projet :** Créer un systeme d’arrosage automatique pour une plante en utilisant
un capteur d'humidité du sol. Lorsqu'un seuil d'humidité bas est détecté, une pompe se met en
marche pour arroser la plante.


https://wiki.fablab.sorbonne-universite.fr/BookStack/uploads/images/gallery/2025-02/image-png.jpeg

- **Technologies :**

- ¥**Arduino** pour le contréle du capteur d'humidité et de la pompe.

- *3D printing** pour fabriquer un petit boitier pour le capteur et la pompe, ou pour une base de
support si nécessaire.

- ¥**Fonctionnalité principale :**
- Le capteur mesure I'humidité du sol.
- Si I'humidité est trop basse (sol sec), le systeme déclenche I'arrosage via une petite pompe.
- Une fois I'humidité du sol suffisante, I'arrosage s'arréte automatiquement.

- *¥*|dée d’amélioration simplifiée :**
- Remplacer I'écran LCD par une simple LED qui s'allume lorsque le systéme arrose, indiquant que
I'irrigation est en cours.

##+# **Plan simplifié de réalisation :**

1. **Capteur d'humidité** : Utilisation d'un capteur d'humidité de sol basique, facile a intégrer avec
Arduino.

2. **Pompe a eau** : Une petite pompe submersible alimentée par Arduino ou via une source
externe.

3. *¥*Arduino** : Programmation de I’Arduino pour surveiller en continu le niveau d’humidité et
controler la pompe d’arrosage.

4. **Bofitier imprimé en 3D** : Un boitier simple pour protéger les composants électroniques et fixer
le capteur dans le sol.

### **Liste du matériel **

- Arduino Uno ou Nano

- Capteur d'humidité de sol

- Petite pompe a eau 5V

- Transistor ou relais pour contréler la pompe

- LED pour signaler I’arrosage

- Tubes pour l'irrigation (si nécessaire)

- Imprimante 3D et filament pour fabriquer un support

### **Avantages **

- Facilité d’assemblage et de programmation pour des débutants.

- Moins de composants a gérer (pas d'écran LCD ou de capteurs supplémentaires).
- Moins de risques d’échec et moins de temps nécessaire.

]
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Qu’en penses-tu ? Cette version te semble-t-elle plus accessible tout en répondant a ton besoin ?
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